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Complete Train Control 
Run Your Trains, Not Your Track!

Features:

	▪ Digitrax SoundFX®v3 Sound System 
Your locomotives will sound in scale like the real thing with SoundFX v3 
Customizable 16, 12 or 8 Bit Sound 
Works with SoundFX 8 and 16 Bit sound projects 
Up to 6 Simultaneous voices 
Download Sounds with Digitrax  Sound programmer and SoundLoader app. 
16 Megabit On board Sound Memory 
Cam input-synchronized steam-chuff option for steam locos 
Scalable Speed Stabilization(BEMF) configured for sound operation

	▪ SoundFX does not require an external rate sensor to vary workload. Cam 
input wire default configured by CV133 as F2 output line.

	▪ Factory 8 Ohm 9x18x4 mm oval speaker mm Oval Speaker makes  
installation quick and easy.

	▪ Smart Power Management- no more booster or programmer shutdowns! 

	▪ Program CVs using any Digitrax Compatible Control system without having 
to buy any extra equipment.

	▪ EZ Drop-in connections for Track, Motor and Function Control

	▪ Series 7 Enhanced Decoder Features.

	▪ Digitrax FX3 Functions-Control lights and functions for prototypical lighting 
effects and on/off control.

	▪ Configurable FX3 lighting effects available on all function outputs.

	▪ Surface mount white front LED headlight. Rear light T1 white LED. 

	▪ Digitrax LocoMotion® System – Lets your trains run like the real thing!

	▪ 2 Digit and 4 Digit Addressing.

	▪ Basic, Advanced & UniVersal Consisting.

	▪ SuperSonic motor drive for silent operation.

	▪ Direct and Operations mode programming.

	▪ Decoder Reset by CV8, with or without speed table reset.

	▪ Transponder Equipped ready for transponding ID on your Layout.

	▪ Power-on Motor Isolation Protection, helps prevent damage to your decoder.

	▪ DCC Compatible.

	▪ FCC Part 15, Class B RFI compliant.

	▪ Operates on DCC track voltage 9V minimum. to 18V maximum.

SDXN147K1E SoundFX®v3
Fits many Kato N locomotives
8 CV-Selectable Steam & Diesel 
Sound Schemes Included

N Scale
Mobile Decoder with SoundFX
Drop-in light board replacement
1.0 Amp/2 Amps Peak
4 FX3 Functions, 200ma output
8 Ohm 9x18x4 mm oval speaker  
100uF Capacitor
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Parts List
1   SDXN147K1E Function Decoder with SoundFX® v3 with 8 Ω 9x18x4 
mm oval speaker  and 100uF cap.
1   Instruction Sheet

Visit www.digitrax.com for the latest information, technical updates and 
additional locomotive-specific installation instructions. CAUTION: 
Programming or layout track voltages should not exceed 18V 
when using this decoder, or non-warranty damage may occur. 

Quick Start Installation Instructions:

1.	 The SDXN147K1E light board form-factor can be used in a number of Kato N 
narrow diesel models, like SD40-2 example shown here.  

2.	 Carefully remove shell.
3.	 Slide the light board to the rear so it can be gently lifted free of frame halves.
4.	 Remove the original factory light board motor clips.  
5.	 Place the motor clips on the decoder with the electronic parts on the top side 

and clips pointing down. 

Motor Clips

Motor Tab

Figure 1: SDXN147K1E: SD40-2 with light board and motor clips removed

Motor Saddle Area
Cab-clip

SDXN147K1E
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6.	 Slide in the decoder into the frames in the same orientation as the lamp 
board. Ensure the motor tab coming from the bottom is under the motor clip 
for proper contact.  Make sure motor clips and tabs do not short to frames in 
motor saddle area 

7.	 Mount the factory 8 ohm 9x18x4 mm oval speaker in frame rear using dou-
ble-sided tape on back to hold down, and insulate from frame halves.  

8.	 Be sure to inspect the speaker diaphragm for magnetic debris or damage, 
which will affect sound quality. Depending on the locomotive model it may 
be necessary to modify the frame or parts of the shell to make room for a 
speakers and enclosure.

9.	 Mount the 100uF electrolytic energy storage capacitor.  In this example it 
can be placed inside the front cab clip area, see Figure 2. Insulate the capac-
itor and its lead wires and retain with double sided tape to ensure it does not 
short across the powered frame halves.

10.	 Inspect the installation before testing the sounds and replacing the shell.  
In particular be sure that wires are correctly soldered and routed and that 
the motor and capacitor leads are not shorted to, frame, track or incorrect 
points.

11.	 Place the loco on an active DCC track powered by a compatible DCC system 
and select the factory default address 03 to enable sounds for testing.

12.	 Be sure F8 (mute) is OFF to allow sound output, and then press  
F1 (bell) or F2 (whistle/horn) ON to check you can hear the associated 
sounds.

13.	 Customize sounds by programming Sound CVs to adjust the desired config-
urations.

8 Ohm 9x18x4 mm oval 
speaker

100uF Capacitor

Figure 2:  SDXN147K1E completed installation
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Speaker Mounting and Baffle or Enclosures: 
The sound performance, volume and efficiency of any attached speaker(s) 
is greatly affected by the mounting system and required baffle or enclo-
sure. The included 8 ohm oval speaker is pre-mounted in a baffle for your 
convenience. Additional baffles or other mounting systems may need to 
be taken into consideration when installing. Baffles are used to isolate the 
speaker diaphragm front sound waves from the “out of phase” rear sound 
waves to minimize sound cancellation, particularly at lower frequencies.  
For the most efficient sound generation, the cubic volume of the baffle 
should be as large as practically possible, and the baffle walls should be 
acoustically rigid so not to allow acoustic interference.

Digitrax SoundFX®v3 System:
For a more prototypical railroading experience, your decoder can be  
customized for your specific locomotive by programming some of the 
Configuration Variables, or CVs, available. 

Digitrax SoundFX v3 lets you make your locos sound “in scale” like the 
real thing! The SoundFX v3 sound CVs used in the range of CV140 to 
CV240 let you customize your decoder without having to reload a new 
sound project. Digitrax sound decoder CVs can be programmed using 
either a programming track or with the operations mode using the main 
line. See the Digitrax web site for more information on programming 
CVs.

Customizing Your Decoder:
This decoder  will initially operate and generate sound using address 03. 
On your Digitrax system, simply select the decoder’s address and the 
sounds will start. [On some DCC systems, it is necessary to select the 
decoder address AND send a command to start the sounds]. 

The factory supplied sound project loaded into the SDXN147K1E sets 
CV60 to 00 for a SD40-2 diesel locomotive scheme. The other 7 preload-
ed schemes are selectable with the value 1 to 7 in CV60. If the locomotive 
you’re installing in is not one of the preloaded schemes you can download   
the appropriate project from the Digitrax website or other project source.

Sound Control Functions: 
The following table shows how each decoder function controls sounds for 
the factory sound project.
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Function# Function Controls Notes

F0 Lights F0 controls directional white/yellow wires

F1 Bell CV146 controls rate, CV157 selects bell type
F2 Horn/Whistle CV150 selects horn choices
F3 Coupler crash Auto coupler/brake set by CV151 max speed

F4 Air feature disable F4 OFF enables pop-off,
drier and starts compressor/air pump

F5
Diesel = Dynamic brake
Fans Steam = Water
Pump turbine

F6 Diesel = Notch Up
Steam = Blow-down

Notch UP if CV155=01 or
02

F7
Crossing Gate Air horn or;
Diesel = Notch DOWN
Steam = Wheel slip

Notch DOWN, if CV155 = 01 or 02
(Crossing Gate active if in Diesel mode and 
CV155=0)

F8 Mute Control F8 ON is mute

F9 Brake squeal

F10 Crossing Gate
Air horn Sequence

F11 Steam = Greaser
F12 Steam = Safety Blow-off

Configuration CV setup:  
The following tables show the CVs used in this decoder sound project and 
how it is set up at the factory to operate various sounds using your throt-
tle.  SFXv3 CV assignments are generally consistent with earlier Digitrax 
decoders.  

Motor Drive Frequency: CV9
CV9 value sets motor frequency in KHz, range 4 to 50KHz for CV values 
01-50.  00 sets a supersonic 16KHz default.

Motor Back EMF (BEMF) Trim: CV10
Value 64 and up to 127 slows down step 1% BEMF motor speed. 00 de-
fault also sets this to 64.  

Motor Control: CV55/CV56/CV57
CV55 sets BEMF static gain, CV56 controls dynamic gain, CV57 sets 
BEMF Intensity.  This is same as prior Digitrax decoders.  

Master Volume: CV58
The value in CV58 sets the master sound volume, and CV140 to CV145 
trim volumes for specific sound types.  If you download a new .wav sound 
file for any of the sounds in the schemes, be careful to set a volume level 
that does not overdrive the speakers, which may cause distortion or 
damage.
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CV# Sound Control Usage Range Default 

Value

01 2 Digit Address 1-127 03

11
Sound Time Out, 06 = Sound ends when loco address is 

unselected, 00=Sound stays on after loco is unselected
06

29

Configuration Register - Speed steps, 2 /4 digit address-

ing, Analog Mode, Normal direction of travel, speed 

tables

06

49 FX effect: Forward Light (FOF) - Headlight 00

50 FX effect: Reverse Light (FOR) - Reverse Light 00

51 FX effect: Function 1 lead 00

52 FX effect: Function 2 lead 00

58 Master Volume (F8 used for Mute) 1=min 00=max 00-15 09

60 Sound Scheme Select 00-07 00

132 Notch Rate 00-255 127

133
Steam CAM config, 128=>EXT cam, 1-127=>DRIVER 

dia”
01-128 63

134 Steam Gear Ratio Trim, 32 = 100% Ratio 00-255 32

135 Mute Volume 00-64 00

140 Prime Mover / Chuff Volume 00-64 60

141 Bell Volume 00-64 25

142 Horn/Whistle Volume 00-64 60

143 Time-Scattered Air Effects Volume 00-64 30

145 Miscellaneous Volumes 00-64 40

146 Bell Ring Rate (1= 24 milliseconds delay) 01-100 07

147 Air Drier Rate (1= about 2 seconds delay) 01-64 02

148 Compressor Run Rate (seconds delay) 00-255 30

149 Air Compressor On Time 00-255 20

150
Horn/Whistle Setup (Default=0, Playable Horn=1, Alter-

nate Horn=2 +128 for playable volume.)

00-07 or 

128-135
00

151

Auto Coupler Sequence Threshold Value-Peak speed for  

coupler/brake when direction change occurs and F3 is 

ON

00-64 48

152 Project Author ID, Digitrax=221 221

153 Project ID 16

154 Steam Blow down / Safety Volume 0-64 60

155 Notching/Slip Mode: 00=Automatic, 00

157 Bell Selector 00-03 00
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Selecting the Sound Scheme on Your SDXN147K1E: CV60   
The SDXN147K1E comes preloaded with 8 different sound schemes, 7 
diesel and 1 Steam.  The active scheme is selected by the value in CV60, 
as shown in following table. 
 

CV60 
value

Factory Sound scheme

0 SD40-2 diesel
1 AC4400 diesel
2 GE Evolution diesel
3 C44-9 diesel  
4 U33 diesel
5 SD70 diesel
6 SD45 diesel

7 4-8-4 Steam 

Selecting Horns/Whistles/Bells: CV150, CV157 
Each Diesel Scheme can be configured with one of 8 different horns using 
CV150, and one of 4 different bells using CV157.  

Each Steam Scheme can be configured with one of 3 whistles using 
CV150 and one of 4 bells using CV157.  To enable playable volume for 
your selected horn or whistle add 128 to the selected value (ex. Playable 
volume on horn 2 is enabled with a value of 130, 02+128=130)

Diesel Notching: CV132 and 155
Sound CV155 is provided to select Diesel engine “notching” modes. The 
default of CV155= 00 provides “automatic notching” that changes the 
diesel RPM settings at 8 distinct throttle speeds that are configured by 
Sound CV132 and follow speed directly. 

Sound CV155=01 selects “semi-automatic notching” mode that allows F6 
ON to increase the notch up from the current throttle setting and F7 ON 
to decrease back down towards the lowest current throttle notch setting. 
Sound CV155=02 selects “manual notching” mode that allows F6 ON to 
increase the notch setting and F7 ON to decrease the notch sound setting, 
irrespective of the throttle speed, which then controls just the motor 
speed.
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Steam Exhaust Chuff / Cam-F2 Configuration and Gear 
Ratio Trim: CV133 and 134
CV133 controls the Steam Chuff / Cam configuration in the decoder. Set 
the value of CV133 equal to the diameter of the driver in inches from 
1-127.  Set CV133 to 128 to enable the external cam lead controlling steam 
exhaust chuffs, which disables F2 output on the CAM gray lead.  
CV134 controls the gear ratio trim, where a value of 32 equals a 100% 
ratio.

Bell and Air Effect Rates: CV146-149
CV146 controls the bell rate or time between rings of the bell, it has a 
range from 1-100 with each increment adding 24ms of delay.  CV147 con-
trols the drier rate, it has a rage from 1-64 with each increment adding 
about 2 seconds.  CV148 controls the Compressor/ Air pump start rate 
and CV149 controls how long the Compressor/ Air Pump runs.

Auto Coupler Sequence Threshold Value: CV151
CV151 controls the speed threshold at which coupler and brake sounds 
are automatically played when the locomotive direction changes and 
function 3 is enabled. CV151 has a range of 0-60.

Loading Other Sound Projects in your SDXN147K1E
Decoder sounds can be re-loaded or customized using a Digitrax SFX 
programmer and your computer with the SoundLoader II software.  Both 
the software and a number of alternate Sound Project files are available 
from the Digitrax Sound Depot web site. It takes only a few minutes to 
download the new sounds to your decoder. 

There are other sources for SPJ sound projects, such as joining the free 
group: https://groups.io/g/AnPRR.  Their file section has over 300 SPJ’s  
that are super-detailed with single locomotive types, versus the factory 
SPJ that has multiple loco samples loaded for convenience.

Prior SFXv1 and v2 Sound Projects can be loaded into SFXv3 decoders if 
sized to fit in sound memory. SFXv3 projects may run on older SFXv1/v2  
decoders with decreased functionality. 

For example, earlier v1/2 decoders may be limited to 3 or 4 sound chan-
nels, whereas SDXN147K1E decoders can run new SFXv3 sound proj-
ects  with up to 6 simultaneous channels in the scheme.  The additional 
channels allow e.g. V3 steam sound schemes to overlap near and far-side 
steam sounds for more realistic steam scheme operations.
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SoundFXv3 DC Operation Mode:
1.	 Digitrax SoundFX v3 decoders will operate on smooth DC power if 

CV29 is default value 06, allowing Analog Mode conversion.
2.	 Sound/motor will not start until about 6VDC on the track.
3.	 It is not practical to Consist/MU decoder equipped locomotives with 

non-decoder equipped locomotives, since they will not operate at 
same speed on shared track DC power.

SDXN147K1E Troubleshooting:

If sound does not start in the decoder when on powered track:
1.	 Make sure you have selected the locomotive address on a throttle. 

The sound will not startup and run unless the locomotive is ad-
dressed by the system.

2.	 Check your installation to make sure the decoder is installed  
properly. 

If the sound output seems distorted:
1.	 Check the speaker cone for magnetic debris that may have collected 

there. Debris on the speaker must be removed and this, or damage 
will cause a loss of sound quality.

2.	 Be sure that the CV58 volume is not set at a level that sets sound 
power too high for the track power and speaker being used.  

If motor does not run:
1.	 Check the motor is properly connected.
2.	 Make sure locomotive address is correct and selected. Activate F0/

lights to see if decoder is powered and addressed properly.
3.	 If Front and Rear lights come uncontrollably solid ON and wink off 

once every 4 secs, the motor is not properly isolated from stray volt-
ages.  Check wiring. 

If the sound in your decoder shuts down after you stop it and 
you are not using a Digitrax system for control:   
On some DCC systems decoders are not addressed by DCC packets after 
the locomotive is set to 0 speed. 

In this case after the CV11 timeout elapses (6 second default), sound will 
“shutdown.”. To defeat this feature, set CV11=00 to remove the timeout 
and shutdown. To make sounds, the decoder must have a command 
addressed to it at least once.
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If you have trouble reading back CVs on the programming 
track:  
This may be due to insufficient current draw for program acknowledg-
ment.  You can always just re-program or write the CV value into a CV to 
get the desired results, even if reading CVs does not work. 

OPS/Mainline mode is recommended for writing to (programming) all 
CVs except CV01, CV17 & CV18 (2 digit and 4 digit addresses). 

If a second DCC decoder is present that is not SoundFX compatible then 
correct read back of CV data is not possible, since CV read back was not 
originally designed for multiple decoder read back.  
 
The SDXN147K1E plays a Steam scheme, but I want the default 
Diesel scheme:   
If the factory sound project with the 8 schemes has not been changed, 
program CV60 back to a value of 00 to reselect the default SD40-2 diesel 
scheme. The SDXN147k1E sound project is on the web site so you can 
reload this if you get lost.  Program CV8 to 8 to restore factory settings. 

I have loaded a new sound project but, the CVs and Function 
controls are not what I expected:   
In SoundLoader II, open the sound project .spj file you programmed with 
“File>Open Sound Project File”.  Now select “View>View Project De-
scription”, the Project description should define how the project operates 
and how CVs and functions are configured for sound generation for that 
specific spj.

I have loaded new .wav files for a bell in 16 bit resolution vs the 
12 bit, but don’t hear much difference. Why?  
With most small speaker systems it is tough to hear difference between a 
12 and 16 bit download, or even an 8 and 16 bit download.  This is partic-
ularly true if the is any noise in the layout room.  In most cases the extra 
cost for “CD quality sound” is not justified.  With a number of sound loco-
motives running at same time it gets quite  noisy, and so many operators 
simply turn down the decoder volumes anyway.

I want to load new .wav files with 12 bit resolution instead of 8 
bit, but do not have enough room in the sound flash.  
Save your project (.spj ) to a new named project: “ File> Save Sound 
Project File As” saves the project file with a new name. Next, right click 



© 2023 Digitrax, Inc. www.digitrax.com— 11 —

on any .wav file you do not need or use, and select “Remove Associa-
tion”.  This will skip  this .wav when pressing the green download “ALL”, 
or  “Program Wavs” button, and the SFX decoder will not output this, 
or ignore/ skip this sound as silence.  This frees up memory for you to 
download 12 or 16 bit .wav files that you wish to use, and be within the 
memory size available.

You can skip all .wav files that are not needed for the scheme you want to 
run, and/or can substitute any .wav versions you may prefer.  Remember 
to save any modified project version with “File> Save Sound Project File”. 
 
If you have free memory, you can download any single .wav by right 
clicking on the .wav entry and selecting “Download this Sound”.

Figure 3: SDXN147K1E: connection diagram
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RH Track
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External CAM input option:   Setting CV133 to value of 128 
enables CAM input for steam chuff synchronization.  If the CAM 
sensor has a voltage of over +5V or -0.5V, e.g. is at track volt-
age, we recommend as best practice to put in a e.g. 10 Kilo-ohm 
1/8watt resistor in series with this input wire, to protect the 
decoder from possible mis-configuration.  If in doubt add this 
CAM input resistor.

The default value of CV129 allows the steam auto-chuff (with no 
CAM input usage) to sense the motor speed to adjust the steam 
exhaust chuff rate partially on sensed motor speed.  CV129 set to 
02 will remove this speed sensing for steam scheme auto-chuff 
operation.

Warranty & Repair
Digitrax gives a one year Warranty against manufacturing defects for 
this product.  All decoders are 100% tested before shipping. Exercise 
caution during installation to avoid cost of a non-warranty return.  Best 
practice is to bench-test a new decoder functionality before installation. 
Visit www.digitrax.com for instructions for tech support and returning 
items for repair.  
 
Please return warranty items directly to Digitrax - DO NOT 
return items to place of purchase.  

Errors and omissions excepted.

SDXN147K1E
Plug ‘N Play Sound + Motor + Function Decoder for N and 
other suitable locos

Made in the USA

2443 Transmitter Road 
Panama City, FL 32404
www.digitrax.com

Need Support? 
helpdesk.digitrax.com
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